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Preface

iewMAX is an icon-based graphical user interface (GUIL)—a set of

features that offer an alternative representation of the DR DOSe 6.0
operating system. An example of an interface is the wristwatch you are
wearing. Its interface is either analog (hour hand and minute hand) or
digital (a numerical readout). Both interfaces tell you what time it is, but -
they require different mental processes for reading the time and different
mechanical actions for setting the time.

Similarly, you can perform all the basic file operations using
the command line or ViewMAX; ViewMAX provides an easier
way of accessing the most-used commands.
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New features in ViewMAX

Various new elements have been added to ViewMAX. These
include the following:

TaskMAX

The TaskMAX interface command lets you access TaskMAX,
which is a utility included with DR DOS. With TaskMAX, you
can switch between applications without exiting your current
application. You can also use the TaskMAX preferences
command to choose how to access TaskMAX.

Split-window mode

The Show free command lets you display the contents of a disk
drive in two side-by-side windows: the folders appear in a tree
structure in the left window, and the contents of a selected
drive or folder are displayed in the right window.

Find

The Find command lets you search your disk drives to locate
one or more files. You can also use DOS wildcards to search for
the file. After the file is located, you can display it in an active
window.

Color schemes

The Color schemes command lets you select several colors and
patterns for the ViewMAX desktop and for the scroll and title
bars.

Undelete

The Undelete command lets you retrieve a file or a directory
that you deleted during your current work session.

Help for dialogs

On-line Help alerts that describe the functions of each dialog
are available.
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How to use this guide

If you are familiar with graphics applications and mouse
techniques, read Chapter 1, “Getting Started,” and then skip to
Chapter 6, “Applications,” for descriptions of what ViewMAX
can do for you.

If you are using a graphics application for the first time, be
sure to complete the tutorial in Chapter 2, “Getting
Acquainted.”

What this guide contains

Chapter 1: Getting started
This chapter tells you how to start ViewMAX.

Chapter 2: Getting acquainted

This tutorial chapter introduces you to the keyboard and mouse
techniques you will be using in ViewMAX, and it leads you
through several of the operations you are likely to perform.

Chapter 3: Windows

ViewMAX divides your screen into windows. This chapter
describes window components and operations. Windows allow
you to view the contents of your disks and folders, display desk
accessories, and so on.

Chapter 4: Folders

Folders contain files and other folders. This chapter describes
how you organize your documents or applications in folders.

Chapter 5: Icons

The basic elements in ViewMAX—disks, folders, applications,
and documents—are shown as icons, or small pictures. This
chapter shows you how to manipulate the icons to perform a
variety of tasks.
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Chapter 6: Applications

This chapter discusses software programs, how they relate to
ViewMAX, and how document types are associated with them.
It also explains how to use TaskMAX with your programs, and
it describes the ViewMAX clock and calculator desk accessories.

Chapter 7. Dialogs

ViewMAZX displays dialogs to provide or ask for information in
connection with an operation that you are performing. This
chapter explains how to obtain on-line Help for dialogs. It also
describes the different types of dialog and tells you how to use
them.

Chapter 8: Menus and commands

This chapter explains how to use the ViewMAX menus and
commands.

Chapter 9: Passwords

This chapter explains how to set passwords for folders,
documents, and applications, and how to set global passwords.

Glossary

Use the glossary for a quick reminder of the meaning of any
unfamiliar terms.
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Assumptions and Conventions

Unless otherwise stated, the examples in this guide assume
your computer has one diskette drive (drive A:) and a hard disk
drive (drive C:). The word disk is used generically to describe
both kinds of drive.

You can use the keyboard or the mouse to move around the
ViewMAX screen and to display dialogs and menus. Mouse is
used generically to refer to the pointing device attached to your
computer. In this guide, the word click always refers to the use
of a mouse.

To make things clearer, the keyboard symbol appears next to
instructions for the keyboard, and the mouse symbol appears in
the margin next to instructions for the mouse when the
techniques for each are quite separate.

ViewMAX uses the term folders to mean subdirectories.

Some ViewMAX commands, when they appear in menus, are
followed by three dots. These dots indicate that a dialog
appears when you choose the command. ViewMAX uses dialogs
to communicate interactively with you: they provide or request
information.

You will notice that some words that appear on screen have
underlined letters, such as File and Options. Wherever you see
underlined letters you can select the option they label by
pressing the Alt key and the underlined letter at the same
time. To choose the File menu, therefore, you press Alt+F
simultaneously.

When you are required to press the plus (+) or minus (-) key,
the plus or minus is shown enclosed in square brackets, but you
do not type the square brackets. For example, Alt+[+] means
that you press the Alt and + keys at the same time.

The J symbol represents the Enter key, which is sometimes
called the Return key.
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Geftffing Starfed

THIS chapter contains the basic information you need to start ViewMAX.

Starting ViewMAX

How you start ViewMAX depends on whether you have
installed it on a hard disk or on diskettes. Instructions for
starting from either type of installation follow. Refer to the DR
DOS User Guide if you want more information on the
installation procedure.

Starting from a hard disk

Assuming your hard disk is drive C:, type the following
command at your operating system prompt:

C>VIEWMAX.!

(d represents the Enter or Return key)

When ViewMAX appears on your screen, you are ready to start
work.
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Starting from diskettes

Insert your VIEWMAX diskette in drive A:. Type this command
when your operating system’s prompt appears:

[DR DOS] A:\>VIEWMAX.

You see an hourglass icon on your screen, telling you your
computer is busy completing your instructions.

In a few moments, ViewMAX appears.
Remove your VIEWMAX diskette from drive A: and set it aside.

Starting ViewMAX automatically (hard disk systems only)

During DR DOS installation, you are asked whether you would
like ViewMAX to be loaded automatically when the computer is
switched on (or rebooted). If you answer YES to this question,
ViewMAX will appear every time you reset the computer or
switch it on. This setting can be changed at any time using the
SETUP utility of DR DOS.




Gefting Acquainted

HIS chapter acquaints you with some basic operations of ViewMAX. It

is written as a tutorial with accompanying illustrations. Be aware that
your screen might look a little different from the illustrations because
ViewMAX is tailored to your specific machine.

To complete the tutorial exercises, you will need a diskette. It
should contain at least one but no more than 15 items (files); it
should not contain any folders (subdirectories). The diskette
you use does not have to meet these requirements but the
instructions will be easier to understand if it does.
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Starting ViewMAX

Start ViewMAX as described in Chapter 1, “Getting Started.”

When ViewMAX first appears, it looks similar to the following
illustration. The components you need to know about for the
tutorial are shown in this illustration.

The top half of the screen is split into two windows: the left one
displays the contents of the current drive in a tree structure;
the right one shows the contents of the selected directory.
Hereafter, we will refer to this as split-window mode.

The bottom window displays icons representing the disk drives
on your computer.

top left window (active)

top right window

menubar —— (inactive)

close box R R S E—

4 folder(s)| 297,595 bytes in 49 file(s).
title bar -
information e
line
i [-1—LEVELZ
selection bar T EUELS

. [-1—LE=
selection frame

left scroll e
arrow _ Disk Drives:

slider . E IZI

DISK E DISKETTE HARD DISK HARD DISK HARD DISK HARD DISK

scroll bar

right scroll bottom window (inactive)
arrow

disk drive
icons ViewMAX automatically detects whether a drive is present and

displays an icon. In addition to physical drives, any substituted
or network drives are also shown.
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Keyboard and mouse techniques

To display menus and choose commands, use combinations of
the Alt key and other letters (shown as Alt+F, for example),
and the Enter key (J). To move around ViewMAX, use the
cursor keys («,—,T, and ).

If you have a mouse, you can use it in ViewMAX; you will move
a pointer around the screen as you move the mouse. To move

the mouse without moving the pointer, lift it up before using it.

(If you have not configured ViewMAX to use a mouse, the
pointer will not appear.)

Note

If your mouse has more than one button, use only the left
one.

Look at the opening display. The first item in the top left

window has a black selection bar around it (as shown to the
left). This bar, which appears only in the left window in
split-window mode, indicates the disk drive or folder whose
contents are displayed in the right window. Surrounding this

bar is a gray selection frame. Use your cursor keys to move the

e * selection frame from item to item (as shown to the left). The

selection frame must appear around an item for you to
highlight and select it.

Mouse techniques

Drag means to press and hold down the mouse button while
you move the mouse. When you drag, you draw a rubber
rectangle on screen that expands and contracts as you move the
pointer. If you draw a rubber rectangle that touches or

surrounds several items, the items are highlighted when you
release the mouse button. Rubber rectangles are always drawn
from upper left to lower right.

Shift-clicking is another way of selecting several items at once,
and it is useful if you want to select items that are scattered
throughout a window. To shift-click, click on the first item, and
then hold down the Shift key while clicking on the rest of the
items you want to select.

To deselect all of the selected items, click in an open area of the
window, and to deselect individual items, shift-click on them.
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Open/Run. ..
Shou contents
Find...

Copy. ..

Delete. ..
Info/Renane. ..
Passuord. ..
Undelete

Format disk...
Exit to DR DOS

Displaying menus

ViewMAX menus contain commands for ViewMAX operations.

Look at the menu bar that appears at the top of your screen.
Notice that each menu title has one letter underlined: File,
Options, View, Help, and ViewMAX.

If you are using the keyboard, press Alt+F. If you are using the
mouse, move the pointer up to the left corner of the ViewMAX
screen and touch the word File.

The File menu drops down from the menu bar.

Each line in a menu is a command. Some commands are
dimmed or grayed out. You cannot choose these dimmed
commands because they are inappropriate for what you are
doing at the time. For example, if no icons are selected when
you display the File menu, the Delete command is dimmed
because ViewMAX doesn’t know what you want to delete.

If you are using the keyboard, you can use Alt+underlined
letter to display the other menus, or, if a menu is already
displayed, you can use the left and right cursor keys to pull
down the adjacent menus. Press Ese to clear the menu from
your screen.

If you are using the mouse, slide the pointer along the menu
bar. When it touches the other menu titles, their respective
menus drop down. If you prefer, menus will only drop down
when you've clicked on the menu title. This operation is set in
Preferences in the Options menu. See Chapter 8, “Menus and
Commands,” for more details. Move the pointer to a blank area
of the ViewMAX screen and click. The last menu you displayed
disappears.
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Activating a window

Only one window can be active at any given time. A window
must be active for you to scroll through the items in it and
select them.

You can tell which window is active by looking for the selection
frame that surrounds the first item in the window. Press the
Tab key and note how the selection frame moves to the right
window. If you press this key again, the selection frame will
move to the bottom window.

If you are using the mouse, you can make a window active by
clicking on it.

Note

To change the bottom window into split-window mode,
activate the window, select one of the drive icons, either
double click on the icon, or highlight it and press Enter,
then choose the Show tree command from the View menu.
To return either the top or the bottom half of the screen to
the full window display, choose the Hide tree command
from the Options menu. See Chapter 8, “Menus and
Commands,” for more information.

Tutorial

In this tutorial, we will introduce you to some of the basic
ViewMAX operations. More detailed information is to be found
in the relevant chapters later in this guide.

Before you begin, check for the following conditions:
O Your diskette is not write-protected.

Q You have inserted your diskette into drive A: and closed the
drive door.

O The top ViewMAX window is displaying the contents of the
current disk drive in split-window mode; while the bottom
window is displaying the available disk drives as icons.

The instructions for using the tutorial are presented in two
ways:

O For keyboard users of ViewMAX.
O For mouse users.
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Tutorial for keyboard users

Changing the top window

Change the top window to the full window display. Press Alt+V
to display the View menu, and then press H (the keyboard
shortcut for the Hide tree command).

The top window now displays the contents of the current disk
drive. To change the display so that it shows only the disk drive
icons, press Alt+F4,

Creating a new folder
Make the lower window active by pressing the Tab key. The
selection frame will surround the icon representing drive A..

Press Enter to open drive A:. All the files on your diskette
appear as icons with their names underneath.

The selection frame is already surrounding the New Folder
icon, so press Enter to open it. The following dialog appears:

lNane: ! ___;
(7] (Cancel] [ OK ]}

Notice that the Name: line has a text cursor on it (1). Type in
the word TUTORIAL and notice how the cursor stays to the
right of the letters you are typing. If you make a mistake press
Backspace to delete the incorrect letters.

Press Alt+O to accept the OK button.

Look at the lower window again. In addition to a new New
Folder icon, you will see an icon for the folder you just created:
TUTORIAL.

Copying afile

You are going to copy a file into the new folder you just made,
so you need to have that folder open.
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Note

When you use the keyboard, the Copy command always
copies from one non-tree window to the other non-tree
window; you need one window displaying the file to copy
and the other window displaying the destination for the
copy. Press Tab to make the upper window active. The
selection frame is already surrounding the disk drive you
want (drive A:); press Enter to open that disk drive.

Open your new folder (TUTORIAL) so that your chosen file can
be copied into it; move the selection frame over the TUTORIAL
icon and press Enter to open it.

The upper window’s title bar changes from A:\*.* to read
AA\TUTORIAL\*.* and the window has only a New Folder icon
in it. You have finished preparing your copy’s destination.

Press Tab to make the lower window active, and use the cursor
keys to move the selection frame around the icon you want to
copy. Choose an icon like either of those illustrated on the left.

Press the Spacebar to select the icon, and then press Alt+F to
display the File menu. Press C for the Copy command; the
following dialog appears:

Copy Folders ~, Files

Folders to copy: 0
Files to copy: 1

[[7]] Ceaneel) (0K )

This dialog shows you that no folders and one item will be
copied. Press Alt+O to select OK. Now look at the upper
window—the file you chose appears beside the New Folder icon.

Renaming a file

To rename the file you just copied into the TUTORIAL folder,
press Tab to make the upper window active. Use the cursor
keys to move the selection frame over the file and press the
Spacebar to select it. Press Alt+F to display the File menu,
then press I for the Info/Rename command.
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The following dialog appears:

= File Information ~ Renane ::

|Mame: MYFILE .pocf|

Size in bytes: 57
Last modified: 29-Jun-90¢ 02:21 anm
Attributes:

@ Read- Urite
O Read-Only

21 [Cancel] [_oOK 1

The name of the file you selected appears, together with its size
and date and time it was last changed. The text cursor (1)
appears at the end of the file name. Press the Backspace key
to delete it one character at a time, or press Ctrl+Backspace
to erase it completely, then type in EXAMPLE XXX. Press
Alt+0O to select the OK button. The file you just renamed
EXAMPLE.XXX appears in the upper window.

Deleting afile

With the selection frame over the file called EXAMPLE XXX,
press the Spacebar to select it. Press Alt+F for the File menu,
then press D for the Delete command. The following dialog
appears:

Delete Folders / Files :

Folders to delete: _0
Files to delete: ____1

"___?_” [Cancel | [ OK ]

Press Alt+O0 to select OK, and the file is deleted.

Going back to the previous display

Press Alt+F4 twice to display the disk drive icons in the upper
window. Each time you press Alt+F4, the active window
displays the previous folder that you opened. If there are no
previous folders, the disk drive icons are displayed. Press Tab
to make the lower window active and press Alt+F4 until disk
drives are displayed in that window, too.
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vV

Leaving ViewMAX

Press Alt+F to display the File menu, and then press X for the
command Exit to DR DOS.

Tutorial for Mouse Users

Changing the top window

Change the top window to the full window display. Move the
mouse pointer up to the menu bar so that it touches the word
YView. When the menu displays, click on the Hide tree command.

The top window now displays the contents of the current disk
drive in a full window. To change the display so that it shows
only the disk drive icons, click on the close box that is in the top
left corner of the window (as shown to the left).

Creating a new folder

Double-click (press and release the left mouse button twice in
quick succession) on the icon representing drive A: in the upper
window. You will see a New Folder icon with the selection frame
around it and all your files displayed as icons with their names
underneath.

Double-click on the New Folder icon. The following dialog
appears:

New Folder

iName: ! _2
E Igancel] OK j

Notice that the Name: line has a text cursor on it (1). Type in
the word LESSON and notice how the cursor stays to the right
of the letters you are typing. If you make a mistake, press
Backspace to delete the incorrect letters.

Click on the OK button. Your new folder, labeled LESSON,
appears in the upper window next to a New Folder icon.
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Copying a file

To copy a file into your new folder LESSON, choose a file to
copy from the upper window. Move the mouse pointer to the
center of the icon, click on it and hold down the mouse button.
(If you double click by accident, don’t worry, because you can
select the Cancel button on any dialog that appears.) The
mouse pointer changes to a hand. With the button still pressed
down, move the mouse hand until it is on top of the LESSON
folder, and then release the mouse button.

The following dialog appears:

E Copy Folders / Files

Folders to copy: 0
Files to copy: 1

This shows that you are about to copy no folders and one item.
Click on the OK button.

Now double-click on the LESSON icon to open it. Inside this
folder is the file icon that you just copied.

Renaming a file

Click on the icon representing the file that you just copied. You
are going to rename it. Move the mouse pointer up to the word
File and touch it. When the menu displays, click on the
Info/Rename command.

The following dialog appears:

File Information ~/ Renane

|Mame: MYFILE .Doc|

Size in bytes: 57
Last modified: 29-Jun-90 02:21 anm
Attributes:

@ Read-Write
O Read-Only

Cancel | [ OK |

The name of the file you selected appears, together with its
size, and the time and date it was last changed.
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The text cursor (1) appears at the end of the file name. Press
the Backspace key to delete it one character at a time, or
press Ctrl+Backspace to delete it all at once. Type in
TESTFILE.XXX. After you click on OK, TESTFILE. XXX

appears in the active window.

Deleting a file

Click on the file TESTFILE XXX to select it. Move the mouse
pointer up to the File menu and then click on the Delete
command. The following dialog appears:

Delete Folders ~ Files :

Folders to delete: 0
Files to delete: 1

Click on OK.
The file TESTFILE. XXX is deleted.

Going back to the previous display

Click twice on the close box in the top left corner of the top
window. Note that each time you click on the close box, the
active window displays the previous folder that you opened. If
there is no previous folder, the disk drives are displayed.

Leaving ViewMAX

Pull down the File menu and then click on the command Exit to
DR DOS.
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Summary of key combinations

This table summarizes the keys you will use to move around
the screen and select items in ViewMAX.

Note

The plus sign (+) means that you press both of the keys at

the same time.

Key(s) Result

Backtab (|<) Selects the previous window or previous

or Shift+Tab dialog field

Tab (—)) Selects the next window or the next dialog field

Down arrow (1)
Up arrow (T)
Left arrow (<)

Right arrow (=)
Pg Up/Pg Dn
Ctrl+Pg Up/
Ctrl+Pg Dn

Enter (J)

Spacebar

F1 (function key 1)

F5
F10

Alt+F4

Alt+F5

Moves to the object below the current object
Moves to the object above the current object

Moves to the object to the left of the current
object

Moves to the object to the right of the
current object

Scrolls the current window display up or down
by one whole window

Scrolls the current window display left and
right by one whole window

Opens the current icon, or closes and accepts the
current dialog, or accepts the default button

Highlights the current icon or dialog button

Displays the Help menu; or, when a dialog
appears, displays the Help card describing
the dialog

Refreshes the active window

Displays the ViewMAX menu

Displays previously opened folder (or click on II,
in the top left corner of the screen)

Resizes the active window; alternates between

full- and half-screen size (or click onE] in the
top right corner of the screen)
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Esc Closes a currently displayed menu or selects
the Cancel option in a dialog

Alt+underlined letter Displays a menu, or selects an item within a
menu or dialog

Backspace Deletes previous character in a dialog’s text field
Ctrl+Backspace Clears a text field in a dialog
[+] In a tree display (left window in split-window

mode), shows the subdirectories that are one
level below the selected directory

-] In a tree display (left window in split-window
mode), hides the subdirectories that are one
level below the selected directory

Alt+[+] In a tree display (left window in split-window
mode), shows all subdirectories below the selected
directory

Alt+[-] In a tree display (left window in split-window
mode), hides all subdirectories below the selected
directory

Home In a tree display (left window in split-window
mode), moves to the first entry of the display

End In a tree display (left window in split-window
mode), moves to the last entry of the display

Check boxes

Some dialogs, such as Set Preferences, include check boxes for
you to specify whether you require certain features. A check box
is empty if the associated feature is disabled, and contains a
cross when enabled. You can switch a check box on and off by
clicking on it, or by selecting it and then pressing the
Spacebar.
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Windows

EN you first start ViewMAX, it displays two windows on the top
part of the screen (split-window mode) and one window on the bottom.
The windows allow you to look at the contents of disks and folders.

Although the windows often contain different icons and can
look slightly different from each other, they are made up of
almost the same components. The following illustration
identifies the components you see when you start ViewMAX:

top left window (active)
up scroll arrow

menu bar scroll bar

—_— down scroll

arrow
close box : B C: .« (TR g

title bar
information : B top right
line . : wi%dgw

(inactive)
selection bar

selection frame

left scroll O
arrow Disk Drives:
slider . .
DISKETTE HRRD DISK HARD DISK HARD DISK 'd'Sk dnve
icons

scroll bar

right scroll
arrow

bottom window (inactive)
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Active window

The window you are working in is the active window. Its title
bar is highlighted and the selection frame surrounds the first
icon in the window.

Note

In split-window mode, the title bar is highlighted in both
windows. But only the active window contains the selection
frame.

Title bar

Information in the title bar tells you, at a glance, which disk
drive and folders you have open, if any.

In split-window mode, the title bar for the left window shows
the letter of the disk drive whose contents are displayed in a
tree structure. The title bar for the right window shows the
drive letter and the name of any folder whose contents are
displayed in the window.

In the full window display, as shown in the bottom window in
the example from the previous page, the title bar reads “Disk
Drives:” to indicate that the icons in the window represent your
disk drives—drive A: is a diskette drive and drive C: is a hard
disk drive. You might have other drives with names such as B:
and D:, and if your computer is part of a network, you will also
see network drive icons with their letters underneath.

After you select a drive and a folder in the full window display,
the title bar changes to show the name of the folder whose
contents are displayed in the window.

If you have your practice diskette from the previous chapter in
drive A:, open the disk icon in the bottom window by moving
the selection frame around it and then pressing Enter (or by
double-clicking on the icon). Note that the title bar now reads
“A:\**” because the window is showing the contents of the root
directory of drive A..
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Information line

In split-window mode, the information line for the left window
shows how many folders the current drive contains. In the right
window, and in a full window, the information line summarizes:

O The number of folders displayed.
O The amount of disk space the files occupy.
O The number of files represented in the active window.

In full window mode, the information line also displays the way
in which the files are sorted.

The following illustration shows the kind of display you will
typically see:

[23 folders. 132,480 hytes in 29 files sorted by date. |

Close box

| Press Alt+F4 or click on the close box to go back to the previous

folder you opened. If there is no previous folder, you see disk
drive icons in a full window.

Note

In split-window mode, the right window does not have a
close box. The close box in the left window controls both
windows.

Resizing box

In the full window display, the size of your window can be
either normal or complete. A complete window fills the screen.
Press Alt+F5 or click on the window resizing box to change
from one size to the other.

It is useful to expand a window to the larger size if the disk or
folder contains more icons than the window can show.

Note

In split-window mode, the left window does not have a
resizing box. The resizing box in the right window controls
both windows.
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The following illustration identifies the components you see
when you activate the top right window:

i inacti top right window (active
top left window (inactive) selection information p right wi (active)

frame titte bar  line

File Options [View Help ViewhAX

resizing box
up scroll arrow
[-1—DRDOS
~~~~~~~~~~~~~~~~~~~ ‘ scroll bar
[-1—VENTURA
L—DpiCT VENTURA  AUTOEXEC.BAK AUTOEXEC.BAT AUTOEXEC.OLD
[-1—TYPESET
=, T D 0D
[-1—LEVEL3 COMMAND.COM CONFIG.BAK  CONFIG.OLD  CONFIG.SVS slider
i I I R I
1 oolR.com  opouT.sAT  oPSETUP.eAT down scroll
S e arrow

Bisk Brlves:

L3 [0 ] B [ [

DISKETTE DISKETTE HARD DISK HARD DISK HARD DISK HARD DISK

bottom window (inactive)

Note that when you activate the right window, the selection
frame moves the right window. The black selection bar remains
in the left window to indicate which disk drive or folder has its
contents displayed in the right window.

To change the top half of the screen so that the contents of the
current drive are displayed in one window, choose the Hide tree
command from the Options menu. (See Chapter 8, “Menus and
Commands,” for more information.)

If you activate the bottom window and then select one of the
disk drives, you will see the contents of the drive displayed in
one window. The following example shows how this might
appear if drive D were selected.
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top left
window
(inactive)

close box

selection
frame

title bar

information
line

bottom
window
(active)

top left
window
(inactive)

bottom left
window
(active)

File Options Uiew Help

Deive C:

[-1C:\
[-1—DRDOS
| L—T1mp
[-1-—VENTURA
| L—piIcT
[-1—TYPESET
[-1—LEVEL2
[-1—LEVEL3
[-1—]
(.
New Foddar 4680 AGUG
&
HLPTOOLS HLPTOOLS.SAV INSTALL
i ] -
PTGUG PTREF SCANHELP
| I R

ViewlAX
Cone,x
c C- - C -
L8 8 8 top right
— -« h )
(| ) O 6 (inactive)
uTIL SarFE MOUSE PRDOS
e [ )
VENTURR TYPESET AUTOEXEC.BAT AUTOEXEC.BAK
B.BAT .BAT M.PAT VENTURA.BAT
Dive ® resizing box
- — A up scroll
C C |
& = S 2 arrow
£
MAGZ NORTON OUTHELP ouTPUT slider
) — D [:l
SCANX WP D.BAT GEM.BAT
r__-| D D D scroll bar
HP.BAT M.BAT N.BAK N.BAT down scro"
arrow

When the bottom window is active, you can also choose the
Show tree command from the View menu to change to split-
window mode, as shown in the following illustration:

File Options Uieu Help UieuwMAX
Drive C: Cine,®
10 folder(s). 4 folder(s). 297,595 bytes in 49 file(s).
[-1C:N\ - . - pr
[-1—DRDOS
I l———TﬂP New Folder DRDOS HOUSE TYPESET .
T - L op g
!_]_T?ng;cr VENTURA AUTOEXEC.BAK RUTOEXEC.BAT AUTOEXEC.OLD (inactive)
[-1—LEVEL2
[-1—LEVEL3 COMMAND.COM  CONFIG.®AK  CONFIG.OLD  CONFIG.SYS
[-1—L]
i
DDIR.COM OPOUT.BAT DPSETUP.BAT DRAW.BAT
1 Drive D: Dive . » +
17 folder(s). 13 folder(s). 2,547 bytes in 4 file(s).
) A A
£-1—DRAW B -
——IMG New Folder 4680 DRAW DRIVER
[~1—INSTALL = = = pes
(| C C .
IE'I"G n.a XNL boﬁom rlght
RELNOT ) - e window
[-1—PTISUPP NORTON PTSUPP RELNOT SCaNX (lnactlve)
L—GRAPHICS —
CANK C - D D
VIEWMAX AGEM D.BAT 1.8AT
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Scrolling and scroll components

Sometimes a window (even when expanded to full size) cannot
display all the icons the disk or folder contains. When this
happens, use the PgUp and PgDn keys to scroll through the
window to see the other icons, or use the scroll bar, slider, and
the scroll arrows if you are using a mouse.

The next illustration shows how the scroll bar represents the
portion of the window that you can see:

IMZTALL.CF3 FLEXTOOL.CIF FLEXTOOL.CHF FLEX

R

COVLET. CHP COULET. $HF

- FMi.CI - FMz2.CHP
] O O B O O
FM2.CIF FM2.TXT FM3.CHP FM2.CIF FM3.TXT FM4.CHP FM4_.CIF
2
W
=2 [ [ )

FM&.CH

[ 3+

scroll bar

this represents the size of
the whole disk/folder
currently displayed

Scroll bar and slider

The scroll bar and slider help you move around within a
window when it contains more icons than can be displayed at
one time. The slider also shows you the approximate size of the
window displayed, related to the overall size of the disk or
folder, and your current location within it.

If the slider extends the full length of the scroll bar, the window
is showing you all the icons in that particular disk or folder.

If the slider does not extend the full length of the scroll bar, the
disk or folder contains more icons than are currently shown in
the window. Use the up and down cursor keys (T and |) or drag
the slider up or down the scroll bar to see the other icons. To
drag the slider, click and hold down the mouse button, and then
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move the mouse. When you have moved the slider as far up or
down as you want, release the mouse button.

If you press the Pg Up and Pg Dn keys, or click on the shaded
portion of the scroll bar rather than dragging the slider,
ViewMAX scrolls up or down by one full window. (Click above
the slider to scroll up and below it to scroll down.)

The size of the slider in relation to the scroll bar tells you how
much of the disk or folder is visible in the window. For example,
if the slider extends half the length of the scroll bar, the window
is showing you half the icons in the disk or folder.

The relative position of the slider inside the scroll bar indicates
which part of the window’s contents is displayed. For example,
if the slider is at the bottom of the scroll bar, the bottom of the
disk or folder is displayed.

Note

In split-window mode, there are two scroll bars, one along
the right edge of the window and one along the bottom
edge. Use PgUp and PgDn to scroll vertically, and use
Ctrl+PgUp and Ctrl+PgDn to scroll horizontally.

Scroll arrows

The up arrow is at the top of the vertical scroll bar; the down
arrow is at the bottom. Press the up and down cursor keys (T
and !) or click on the up and down arrows to scroll one line of
icons toward the top or bottom of the folder or disk.

In split-window mode, the left window has a horizontal scroll
bar. The left arrow is at the left of the scroll bar; the right arrow
is at the right of this scroll bar. Press the left and right cursor
keys (< and —) or click on the left or right arrow to scroll
toward the left or right of the display.
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Summary of scrolling techniques

The following illustrates the window scroll components in the
normal window display:

Use Pg Up and
Pg Dn or click in
the scroll bar to
scroll one full
window of icons in
either direction

Use T and { or™ click on the
drag the slider  scroll arrows to
upordownto  scroll one line
scroll in that of icons up or
direction down

In split-window mode, there is also a horizontal scroll bar, as
shown in the following illustration:

Use Ctrl+Pg Up and Ctrl+Pg Dn or
click in the scroll bar to scroll one full
window horizontally

Kl 4
Use < and — or Click on the scroll
drag the slider left arrows to scroll one
or right to scroll in character left or right

that direction
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Other window operations

The following window operations are described in detail
elsewhere in this guide:

Show/Hide tree

The Show tree command lets you display the contents of a drive
in two windows: a tree display of the directories appears in the
left window; the contents of a selected directory or drive appear
in the right window. The Hide tree command returns to the full
window display. These commands are described in Chapter 8,
“Menus and Commands.”

View contenfts as ...

In split-window mode, you can display the folders and files in
the right-hand side of the window as icons or text, while the
left-hand side remains as a tree. You can display the contents of
a full window as text or icons. These options are described in
Chapter 8, “Menus and Commands.”

View contents in a different order

Use the commands on the View menu to arrange the window
contents in various ways. You can view the contents arranged
by file name or type, file size, or the date the file was created or
last modified. You can also choose to display only a subset of the
files. The View menu is described in Chapter 8, “Menus and
Commands.”

Save your windows

If you want your windows and their contents to appear a
certain way each time you start ViewMAX, read about the Save
preferences command under the Options Menu commands
section in Chapter 8.
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Folders

'VieWMAX displays folders, which are the equivalent of directories. You
use the folders in much the same way you use them in a file cabinet.
That is, you organize your information into different folders so you can
locate it quickly and easily when you need it.

When you first open a disk icon and the disk contains folders,
you see the folders in the window. Until you open one of the
folders, you are in the root directory of that disk. A disk does
not have to contain folders, and it can contain files in the root
directory.

Creating a new folder

Folders are represented in ViewMAX by an icon like the one
shown to the left. You can open folders to display their contents,
place files inside folders, remove them from folders, and much

more.
= The first item in every window is always a folder named “New
Folder” (except when the window displays disk drives).
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To create a new folder, select the New Folder icon by moving
the selection frame around it and then pressing Enter, or by
double-clicking on the icon. ViewMAX then displays the New
Folder dialog so you can type the name of the folder you are
creating.

As you type the folder name, it appears on the Name: line of the
New Folder dialog. The folder name can be up to eight
characters long—you can also add a three-character folder type.
The optional folder type follows the period (.) in the folder
name. Note that when you press the period key (.) the text
cursor moves to the right of the period on the screen so that you
can enter the three-character folder type.

After you type the folder name, select the OK button. The
dialog closes and an icon for the new folder appears in the
active window. Another New Folder icon replaces the one you
just used, so you always have a new folder available.

Folders inside other folders

In the tutorial in Chapter 2, “Getting Acquainted,” you learned
how to create a new folder and copy a file into it. You can also
create a folder inside another.

From the root directory of the drive you are working on,
perform the following operations:

Open the drive to show the folders and files that are
present.

@ Move the selection frame over the New Folder icon and
press Enter, or double-click on that icon.

El Type the name you want for the folder and select the OK
button.

When you see the folder with its new name appear in the
active window, open it by moving the selection frame over
it and pressing Enter (or double-clicking on it).

@ Repeat steps 2 and 3 to create a second new folder inside
the first.

Note

If you create too many nested folders (folder a inside folder
b inside folder ¢ inside folder d, and so on), ViewMAX
displays a dialog to let you know that you cannot create any
more. You probably will not encounter this dialog, however,




4: Folders 29

because you will normally not need to have more than a few
levels of nesting.

Copying folders

You cannot have two folders with the same name in the same
place (that is, in the same root directory or in the same parent
folder). If you do try to copy a folder to the same place,
ViewMAX asks you to enter a different name for the copy, and
the following dialog appears:

Nane Conflict

Current name: CONFIG .OLD
ZCopg’s nane: CONFIG .OLDH

@] (CStop_ ] [Cancel] [ 0K ]

Type in a new name for the copy, then select the OK button to
accept it. Select the Cancel button to cancel copying the current
folder (if you have chosen several folders to copy at one time,
the remaining folders will still be copied). Select the Stop
button to halt the entire copy process.

When you copy one folder to another and the two have different
names, ViewMAX copies the first folder and its contents to the
destination.

When you copy one folder to another and the two have the same
name, ViewMAX copies only the contents of the first folder to
the second.

Placing files inside folders

Whenever you copy a file to a folder, you are actually placing a
copy of that file in the folder; the original file stays in its
original location.

Look back at the section “Copying a file” in the tutorial in
Chapter 2, “Getting Acquainted,” to remind yourself how to put
files inside folders. Remember to look at the appropriate
section—there are instructions for mouse as well as keyboard
users.
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Deleting files from folders

Follow these steps to delete a file from a folder:

Open the folder containing the file you want to delete by
moving the selection frame around the file and then
pressing Enter, or by double-clicking on the file.

@ Select the file you want to delete.
Choose the Delete command from the File menu.
Select the OK button to delete the file.

If you want to delete several files at once, you can select them
by moving the selection frame over each in turn. Then press the
Spacebar, and finally choose the Delete command. Or, if you
are using the mouse, you can click on the first file, hold down
the Shift key, and then click in turn on the other files (called
shift-clicking). To remove them, choose the Delete command.
Alternatively, you can draw a rubber rectangle around a group
of files and then delete them. Refer back to the relevant tutorial
section in Chapter 2, “Getting Acquainted,” if you need to
remind yourself how to use these techniques.

Deleting folders

Follow these steps to delete a folder:

Select the folder or folders you want to delete.
Choose the Delete command from the File menu.
Select the OK button to delete the folders.

Note

When you delete a folder, you also delete all the icons it
contains, including other folders and their contents.
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Renaming folders

Follow these steps to rename a folder:
Select the folder you want to rename.
Choose the Info/Rename command from the File menu.

When the Folder Information/Rename dialog appears,
press the Backspace key to delete the old name one
character at a time, or press Ctrl+Backspace to delete
the whole name.

Type the name of the new folder.
Select the OK button to give the folder the new name.
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lcons

CONS are pictures of items you use with ViewMAX. A different style of
icon represents each of the following types of items:

O Disk drives
O Folders

O Applications
O Documents

Disk drive and folder icons

Disk drive icons (like the ones shown to the left) are labeled
DISKETTE with their corresponding drive identifier letters: A:, B:, C:, and
S0 on.
c
Folder icons are labeled with the folder name you provide when

HARD DIsK you create the folder. Folders always appear as the first icons in

~ a window (unless the window displays disk drives). The folder
name appears in the window title bar when you open the folder.
NETWORK For more information about folders, see Chapter 4, “Folders.”
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Application and document icons

Application and document icons are labeled with their name

(up to eight characters), followed by a type identifier (up to
EDITOR.EXE three characters). The name and type are separated by a
- period (.).

The next figure shows a sample of the icon set that represents
different types of applications and the documents they create.
In each set, the icon on the left represents a type of application,
and the one on the right represents the document it creates.
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Communications Database Draw
@’ ABC i _'7

1+1=2 0 # ‘
Education Generic

%u ll,

. 5 O
Multi-function QOutline Paint

(=
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Programmer’s tool Project Spreadsheet Word Processor
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Note the icons labeled “Generic” in the preceding figure.
Unless you tell ViewMAX to use a different set of icons to
represent an application and its documents, the generic icons
are used. You can use the Configure application command
(described in Chapter 6, “Applications”) to select a different set
of icons to represent an application and its documents.
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Applications

PPLICATIONS are software programs you run on your computer to
create and process information.

Application and document types

Both applications and documents have names. The name
appears beneath the icon when it is displayed in a window. The
name can contain up to eight characters.

Applications and documents can also have a ¢ype, which follows
the name. The type can contain up to three characters. A period
(.) separates the name and the type.

There are conventions for labeling applications and documents
according to their type, so that you can easily identify them.
Here are some examples:

EDITOR.EXE

The name of the icon is EDITOR and its type is EXE (indicating

a DOS application). DOS applications also use types COM and
BAT.

INCOME.GRF

The name of the icon is INCOME and its type is GRF; this is a
graph-type document created with the graphing part of Digital
Researche Presentation Teamn.




38 ViewMAX User Guide

Applications are of the following types:

@ BAT (batch files).

0 COM (command files—DOS applications).

0 EXE (executable files—DOS applications).

0 APP (Digital Research graphics applications).

Documents can be any type that you or the application program
want them to be.

Starting applications

There are several ways to start applications in ViewMAX.

Normal startup
The most common ways to start an application are as follows:

3 Select the application icon with the cursor keys and then
press Enter; or, double-click on the application icon.

Q Select the application icon and then choose the Open/Run
command from the File menu.

If you use either of these methods to start a DOS application,
the Open Application dialog might appear; it is explained later
in this chapter.

Startup with a specific document

You can start an application and have it immediately load a
particular document. To start an application this way, do either
of the following:

[ Open the document icon that you want to load, either by
selecting it with the cursor keys and then pressing Enter, or
by double-clicking on it.

O Select the document icon and then choose the Open/Run
command from the File menu.
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Note

Before you can start an application this way, it must meet the
following requirements:

O You must configure the application. This process is described
later in this chapter.

O You must have specified the document type in the Configure
Application dialog. If you have not configured the document,
you will need to complete the Open a File dialog.

Q Ifthe application is a DOS application, it must be one that
lets you name a document when you start it. You normally
start such an application from the command line by entering
the name of the application followed by the name of the
document you want to edit.

O The application and the document must be in the same
folder, or the application must be in a search path. Search
paths are described later in this chapter.

Open Application dialog

Some DOS applications let you specify the name of a document
you want to use or let you enter parameters that control how
the application operates. If you configure the application as this
type (see Configuring applications below), the Open Application
dialog appears when you start the application from ViewMAX:

Open fApplication :

e AN A JIEY AT
(Paranetcrs: ' I

You can enter a document name or program control parameters
in the Parameters field. (Refer to the documentation for the
application to find out what you can enter.)
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Configuring applications

When you configure an application, you are telling ViewMAX
how you want the application to run. You can also choose a
different icon to represent the application and its documents.

You configure an application by completing the Configure
Application dialog, shown in the following illustration:

: Configure Application

fipplication name: ¥ .BAT

NANRRRN

[?] [(Benove | [ Cancel ] [Install ]

To configure an application, follow these steps:

Select the application. The application type must be of the
type BAT, COM, EXE, or APP. If an application is already
configured and you want to reconfigure it, you can either
select one of its documents or the application itself.

Choose the Configure application command from the
Options menu to display the Configure Application dialog.

In the Documents: fields, enter the document types you
want to associate with the application. For example, you
might want to associate document types DOC and TXT
with documents you create with your word processing
application. You can enter as many as eight types. Use the
Tab key, Shift+Tab keys, cursor keys, or the mouse
pointer to move between fields.

If the application automatically assigns a type to its
documents, enter that type in the first field. Check the
documentation for your application to see if it assigns a
type to its documents.
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If the application does not automatically assign a type,
enter one or more of your own choosing. Be sure you assign
this type to any documents you create with the application.

If you associate the same document type with more than
one application, ViewMAX recognizes only the last one you
configure.

E If you are configuring a DOS application that lets you
enter other parameters in addition to the document name
when you start the program, switch on the check box for
the “Takes parameters” field. When you start a DOS
application of this type, the Open Application dialog
appears, as described earlier in this chapter.

In the Icon type window, look at the application and
document icons ViewMAX currently uses to represent
these items. If you do not want to use a different set of
icons, skip ahead to step 9.

The window contains a scroll bar, a slider, and scroll
arrows, just like a ViewMAX window. Scroll the window
contents until the window displays the set of icons you
want to use. If you are using the keyboard, move the
selection frame over the down arrow symbol and press the
Spacebar to scroll downwards, or move the selection
frame over the up arrow symbol and press the Spacebar
to scroll upwards. If you prefer, you can use the generic
icons in the window.

I;f)—] When everything in the Configure Application dialog is set
the way you want, select the Install button. If you want to
leave the dialog without making any changes, select the
Cancel button.

Saving the configuration for an application

When you configure an application, it remains configured only
until you stop ViewMAX, unless you use the Save preferences
command to save the configuration. Be sure to read the
description of the Save preferences command in Chapter 8,
“Menus and commands,” before you use the command. This
command also saves other settings that affect the operation of
ViewMAX.

ViewMAX allows you to configure about fifty applications.
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Removing the configuration for an application

When you remove the configuration for an application, you
break the association between the application and any
document types you specified in the Configure Application
dialog. Once you remove the configuration, you cannot start the
application by opening one of its documents. Furthermore,
ViewMAX uses the generic set of icons to represent the
application and its documents. However, you can still start the
application by opening its icon.

Follow these steps to remove the configuration for an
application:

Select the application icon.

@ Choose the Configure application command from the
Options menu.

When the Configure Application dialog appears, select the
Remove button.

Search paths

A search path tells ViewMAX where to look for an application
when you open a document icon.

Unless you change it, ViewMAX goes through a standard
search path to find your applications. The standard search path
includes the following:

O The folder or the root directory where the document icon you
opened is located (the “current” folder).

3 The folder on the disk where DR DOS is located.

The search path is defined using the PATH command. Refer to
the DR DOS User Guide for more details.
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TaskMAX

TaskMAX is a utility included with DR DOS that lets you
switch between applications without exiting your current
application. (See the DR DOS User Guide for complete
information on how to start and use TaskMAX.)

After you start TaskMAX, you display the TaskMAX menu by
using the Ctrl+Esc command. In the TaskMAX menu, you
create a list of active applications called the task list. You can
then use TaskMAX to switch between these applications; you
can also add or delete applications from the task list.

You must start TaskMAX before you enter ViewMAX.

Using ViewMAX to entfer TaskMAX

When you first start ViewMAX, the display of the TaskMAX
menu with the Ctrl+Esc command is the default. To use
ViewMAX to enter TaskMAX, perform the following steps:

Choose the TaskMAX preferences command from the
Options menu. This displays the TaskMAX Preferences
dialog.

Select the box beside the “ViewMAX controls TaskMAX?”
option and then select OK. You can now enter TaskMAX by
using the TaskMAX interface command from the Options
menu.

Choose the TaskMAX interface command from the Options
menu. This displays the TaskMAX Interface dialog, which
shows the list of applications you started under TaskMAX.

Select a task, and then select the appropriate button to
Run, or Delete it. To insert another task into the task list,
select the Insert button.

Choose the Save Preferences command if you want to use
ViewMAX to access TaskMAX each time you start
ViewMAX. See Chapter 8, “Menus and Commands,” for
more information about all these commands.

Note

You can only use the Ctrl+Esc command to display the
TaskMAX menu from within ViewMAX if the “ViewMAX
controls TaskMAX?” option in the TaskMAX Prefererences
dialog is not selected.
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Using the TaskMAX menu from within ViewMAX

When you first start ViewMAX, you can use the Ctrl+Esc
command to display the TaskMAX menu.

If you decide to use the ViewMAX to enter TaskMAX, you must
select the box beside the “ViewMAX controls TaskMAX?” option
in the TaskMAX Preferences dialog. To restore the use of the
Ctrl+Esc command to display the TaskMAX menu, you must
deselect this option in the TaskMAX Preferences dialog.

See Chapter 8, “Menus and commands,” for more information
about the TaskMAX preferences command.

ViewMAX accessories

The ViewMAX accessories (the clock and the calculator) are a
special type of application: you can use them at any time while
the ViewMAX windows are displayed.

Using ViewMAX accessories

You start both the clock and the calculator the same way, by
choosing their name from the ViewMAX menu. Do this either
by moving the cursor keys to highlight the name and then
pressing Enter, or by clicking on the name. Alternatively, you
can press A or C to display the Calculator or Clock.

If you click in a window while the clock or calculator is on your
screen, the title bar dims and the accessory goes behind the
windows. If you click on the visible part of the accessory, it
returns to the front of the windows and is active again. (While
calculator is hidden, it continues to store the values you entered
on it.) You can also use the Tab key to make each window in
turn active, including any open accessories.

It is possible for a ViewMAX accessory to be entirely covered by
a window. If this happens, choose the accessory again from the
ViewMAX menu to return it to the front of the windows.
Alternatively, you can expose hidden accessories by pressing
the Tab key several times.

You can use the accessory title bar (while the accessory is
active) to move it to a different location: click on the title bar
and then drag it to wherever you want (no keyboard equivalent).

If you are using both ViewMAX accessories at the same time,
only one can be active. When you click on any part of the
accessory, or press the Tab key, the accessory becomes active.
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close box title bar

Calculator

Note

If you are just using the keyboard, you can display both
accessories at once, but only the last one you chose will be
active. Press the Tab key to display each window and each
accessory in turn.

To put an active accessory away, press Alt+F4 or click on its
close box.

Calculator

The ViewMAX calculator resembles a standard calculator. Use
the following means to operate it:

O Enter numbers using your keyboard’s standard number keys
or the numeric keypad.

O Click on any of the keys.

If your typing on the numeric keypad does not enter numbers,
press the Num Lock key.

You can use the keyboard keys for all remaining functions. For
example, you can either click on the + key or type the +
character. Similarly, you can either click on the MR key or type
the M and R characters.

The +\~ key on the calculator changes the sign of the amount in
the value window to its complement. The keyboard equivalent
for this function is a backslash (\).

* represents the multiply key and forward slash (/) represents
the divide key.
Memory Keys

You can use the memory keys (M+, M-, MR, and MC) to add,
subtract, recall, and clear values from a memory location in
your calculator.

M+

This key adds the amount in the value window to memory. A
small “m” appears at the left side of the window to let you know
that you have stored a result.

M-

This key works like M+ except that it subtracts the value from
memory. .
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MR

This key recalls the present value from memory and displays it
in the value window.

MC

This key clears the value from memory. It does not clear the

value from the value window, so you can use it in further
calculations.

EC and C Keys
EC

This key clears your last entry from the value window. You can
continue your current calculations.

C

This key clears the value window and terminates your current
calculations.

Clock

When you choose the clock accessory, ViewMAX displays the
window shown below:

To reset the time or date in the clock,
: you must change each value (hour,
2 APR 90 minute, day, month, and year)

: separately.

Setting the clock with the keyboard

The right and left cursor keys move through the hour, minute,
am/pm, day, month, and year settings, plus an off position
where no settings are highlighted.

If you want to reset the hour, for example, press the right arrow
key to highlight it, then type the new time or use the up and
down cursor keys to decrease or increase the time.

You can only change the am/pm and month settings using the
up and down cursor keys; you cannot type the setting.

Your computer will beep if you try to set an invalid date or
time; it will not let you set the date to 30th February, for
example.

When you have finished setting the date, press Alt+F4 to close
the clock, unless you want to set the alarm.
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To set the alarm, follow these steps:

Press the Enter key to change the clock from date to
alarm mode. The C below the close box symbol changes to
an A, and the time display is reset to 12.00 am.

Use the cursor keys to highlight the settings you want to
change and then type the new settings.

Turn the alarm on by pressing the Spacebar. When the
alarm is off, the musical note is dimmed.

When you have finished setting the alarm, press Alt+F4 to
close the clock. The alarm will go off whether you have the
clock displayed or not, as long as you are in ViewMAX.

] [ed

Note
The alarm is reset when you leave ViewMAX.

Setting the clock using the mouse °

If you want to change any of the settings of the clock, follow
these steps:

Click on the setting you want to change. It will become
highlighted.

Ez] Edit the setting by typing the new value, or by pressing
the up and down cursor keys. The up key will increase the
current value by one and the down key will decrease the
value by one.

E] You can only change the am/pm and month settings by
using the up and down cursor keys; you cannot type these
settings.

Click on the close box to close the clock, unless you want to
set the alarm.

Follow these steps to set the alarm:

Click on the mode indicator below the close box. It
changes from a C to an A to let you know the clock is now
in alarm mode, and the time is reset to 12.00 am.

Set the time you want the alarm to sound by changing the
hour and minute, as explained above.
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Click on the musical note at the far right side of the clock
to turn the alarm on. When the musical note is dimmed,
the alarm is not set.

Click on the close box to put the clock away. The clock does
not have to be displayed for the alarm to sound, but you
must have the ViewMAX windows displayed at the time.

Note

The alarm is reset when you leave ViewMAX.




Dialogs

IALOGS appear on your screen when ViewMAX needs to communicate

with you. The dialog conveys information you need or asks you for
information ViewMAX needs to complete your instructions. Dialogs are of
two types:

O Information
O Data entry

If a command in a menu has three dots following it, a dialog
will appear when you select that command.

Help for Dialogs

On-line Help is available for each dialog. To display the Help
alert that describes a dialog, press F1 when the dialog appears,
or click on the question mark button (?) in the dialog. To exit a
Help alert, press Enter, or Alt+O, or click on OK.

The following is an example of a Help alert.

Use this dialog to obtain information iz

about a file. You can also set the file™
attributes.

Exit buttons

Every dialog has at least one exit button. In its simplest form,
an exit button provides a way to leave the dialog.
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The dialog in the next illustration has one exit button labeled
Cancel.

w There is not enough memory to

complete the current operation.

After you read the message, put the pointer on the exit button
and click, or press Alt+C. The dialog disappears and you can
resume your work.

Many dialogs contain more than one exit button. Each button
provides a different option.

The next dialog illustrated has two exit buttons, Cancel and
Retry.

? Drive A: is not responding. You must

use the right kind of disk, insert it

correctly, and close the door. If the

problemn is with a hard disk, check the
disk’s connections.

Note that the Retry button has a heavier border than the
Cancel button. When an exit button has a thick border like this,
pressing Enter is the same as clicking on that button, and it is
called a default button. Alternatively, you can press
Alt+underlined letter to select the appropriate button, so
Alt+C in the example above will select Cancel, and Alt+R will
select Retry.

Information dialogs

Information dialogs enable ViewMAX to obtain or provide
information. An example of an information dialog is the one you
see when you choose the Info/Rename command after selecting
a folder icon.

Many information dialogs contain only one exit button. After
you have read the message, click on the exit button or press
Enter or Alt+underlined letter to remove the dialog and
continue your work.
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EVE

Some information dialogs warn you of a problem that has
occurred or might occur if you continue what you are doing.
Most dialogs of this type contain one of the following icons:

This icon indicates you should make note of the message
inside the dialog and then continue with your work.

This icon is used in various alerts, including Help alerts, to
indicate that you should read the text on the alert.

This icon usually indicates that you should stop what you are
doing because an error has occurred.

Data entry dialogs

Data entry dialogs appear when ViewMAX needs information
from you to complete an operation.

Most data entry dialogs contain areas where you type the
required information. These areas are called data entry fields.
The dialog might also ask you to enter the information by
selecting various buttons. For example, if you select a document
icon and then choose the Info/Rename command, you see the
File Information / Rename dialog, as shown below.

# File Information ~ Rename i

|Mame: AUTOEXEC.BAT!

Size in bytes: — 438
Last modified: 2Z2-May-91 08:29 an
Attributes:

@ Read- Write
O Read-Only

[(Cancel j [ __OK [

The File Information / Rename dialog is a combination
information and data entry type; it contains some information
you can change and some that you cannot change.

The Name: field is a data entry field, as indicated by the text
cursor (a vertical bar) at the end of the field. The field contains
the name of the icon you selected.

Press the Backspace key to move the text cursor back one
space at a time and erase that character. Press the
Ctrl+Backspace keys to erase all characters in the field. Press
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the left and right cursor keys to move within a text field
without deleting characters.

You can then type whatever characters you want in the field—
they appear at the text cursor location. (The table at the end of
this chapter explains how to move the text cursor and enter
information in a data entry dialog.)

You can enter information only in the field where the text
cursor is located, and only when the selection frame surrounds
the field. To move the text cursor to a different field, place the
pointer anywhere in the field and click, or press the Tab, the
Shift+Tab, or the cursor keys. If the text cursor does not
appear in a field or the selection frame skips a field, you cannot
enter information there.

The next two fields in the dialog (Size in bytes: and Last
modified:) are not data entry fields. You cannot change the
information they contain.

Below the Attributes: message are two buttons labeled
Read/Write and Read-Only. The Read/Write button sets the
document so that it can be read from and written to the disk.
The Read-Only button sets the document so that it can be read,
but information cannot be written to it, nor can it be deleted.

The Read/Write and Read-Only radio buttons are similar to
buttons on a car radio because you can select only one at a
time. When you select one, the other becomes de-selected.

At the bottom of the dialog are the exit buttons. If you make a
change in the dialog, click on the OK button (or press Alt+Q)
and ViewMAX saves your changes. If you do not make any
changes, or if you make changes but do not want them saved,
click on the Cancel button (or press Alt+C).

The following table lists the keys you can use to move the text
cursor and selection frame, and to enter information in data
entry dialogs.
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Key Effect
- Moves the text cursor right one character at a time
without deleting / moves one field to the right
«— Moves the text cursor left one character at a time
without deleting / moves one field to the left
Tab Places the selection frame in the next data entry field
Shift+Tab Places the selection frame in the previous data entry field
d Moves the selection frame to the next row of dialog buttons
T "Moves the selection frame to the previous row of dialog
buttons
Del Deletes the character to the right of the text cursor
Backspace Deletes the character to the left of the text cursor
Ctrl+ Deletes all the characters in the field
Backspace

Esc Cancels the dialog and closes it
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Menus and
Commands

EN you type Alt+underlined letter (File, Options, View, Help,or
ViewMAX), or place the pointer on one of the titles in the menu bar, a
menu displays. These menus list the commands you can use to complete
operations in ViewMAX.

This chapter describes the commands that appear in each
ViewMAX menu. Pictures of the menus follow with brief
descriptions of each command. Complete descriptions of each
command appear later in the chapter.

All the commands can be chosen using either the keyboard or
the mouse—typing a certain sequence of keys is the same as
using the pointer to display a menu and then click on a
particular command.

Display the File menu. Notice that the words Open/Run, Show
contents, Find, Copy, Delete, Info/Rename, Password,
Undelete, Format disk and Exit to DR DOS all have one
underlined letter. To choose a command with the keyboard,
press the underlined letter. For example, to obtain information
about a file by using the Info/Rename command, follow these
steps:

Press the Tab key to make right window active.
Place the selection frame over the file.

Press the Spacebar to select the file.

Press Alt+F, and then press L.
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File menu

Opens the currently selected folder or file,
or runs an application.

Displays the contents of the selected file as

readable text or in hexadecimal form.

(see Chapter 9, “Passwords”).
Retrieves a deleted file or folder.

Formats your currently selected diskette.

Open/Run. .. / Finds the specified file and then displays it
%l.mg contents / as a highlighted icon in the active window.
nd. .. / Allows the selected folders or files to be
Copy. .. copied to another window.
Delete... Deletes all currently selected items. You can
Info Renane. .. use the Undelete command to recover them.
Passuord. .. \ . .
Shows you information about the currently
Undelete . .
selected item, and allows you to rename it.
Format disk... Used to assign or remove a password that
Exit to DR DOS \ controls access to folders and documents

Stops ViewMAX and returns you to the
command line of the DR DOS operating
system.
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Options menu

Lets you specify how you want an
/ application to work with ViewMAX.

Lets you specify how you want some

Configure application... aspects of ViewMAX to work.

Allows you to specify a password to be used
P ‘e
Preferences / wherever a folder or document is password-

Global passuord...
Color sghemes . protected. For more details, see Chapter 9.
Save preferences TT~Lets you choose the color schemes in

ViewMAX.

Saves your current preferences and window
arrangement for ViewMAX.

TaskMAX Preferences...
TaskMAX Interface...

Enter DR DOS commands Lets you specify how you want TaskMAX to
operate in ViewMAX.

Lets you switch to other applications from
ViewMAX.

Lets you enter commands at the operating
system prompt without stopping ViewMAX.
To return to ViewMAX, type the following
at the operating system prompt:

EXIT.
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View menu

Closes the currently-displayed folder and
replaces it with the previously-displayed
folder or disk drive display.

Close Alt+F4 / ) . .
Resize Alt+Fs |—————— Switches between displaying the current
Refresh F5 window at normal and at full-screen size.
D Refreshes the active window to display its
Shou tree \current contents.
Show as ?e&t Displays a window’s folders as a tree
» Shou as icons . .
structure in one window and the contents of
> Name order a selected drive or folder in another window.
Type order Displays the active window’s folders and
Size order files as text, with additional information.
Date order Displays the active window’s contents as
Wildcards icons. See Chapter 5, “Icons,” for more
— — information.
These four commands govern how the
contents of the window are sorted.
Allows you to display a subset of the files in
a folder by giving ViewMAX a list of
wildcard specifications.
Note

All the View menu commands refer to the active window.
You can have each window set up in a completely different
way; for example, the upper window can show icons sorted
in name order, and the lower window can show just BAT
files in date order displayed as text.
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Help menu

— Displays a summary Help screen for menus.

Menus... . .
Dialogs. .. —— Displays a summary Help screen for dialogs.
Windous. .. — Displays a summary Help screen for
Irees...

\Windows.
Displays a summary Help screen for the left

window in split-window mode.
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ViewMAX menu

Displays the opening screen, which shows
the version and date of the ViewMAX
software.

Displays the calculator desk accessory on
the screen.

Displays the clock desk accessory on the
/ screen.

Information...
Calculator
Clock
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Eile menu commands

The File menu contains all the commands that act on
individual folders, applications, and documents.

Open/Run command

The results of the Open/Run command depend on the item that
is selected when you choose the command. The following table
describes what happens in each case:

Item Command action

Disk Displays the disk’s contents in the active window.
Folder Displays the folder’s contents in the active window.
Application Starts the application on your computer if you have

configured the application. If you have not, it prompts
you for the name of a document to load or a parameter
that the application takes, and then it starts the
application.

Document If you have configured the application that created
this document, the application starts and opens the
document you selected. If you have not configured
the application, ViewMAX prompts you for a
program name and then loads that program.

Show contents command

This command uses a full-screen window to display a text file
as readable text or a binary file in hexadecimal form. Press
Ctrl+T or select Text from the View menu to switch between
the text and hexadecimal displays. The information line at the
top of the display tells you how many lines and how many bytes
the file contains.

Note that you cannot edit this display. To scroll through the
text, use the Pg Up and Pg Dn keys, and to scroll left and
right (if the display is wider than the window), use Ctrl+Pg Up
and Ctrl+Pg Dn. If you are using the mouse, click on the
appropriate scroll bar to display different areas of the window.

Click on the close box to clear the display, or press Alt+F4.
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Find command

Use this command to locate a file. When you choose this
command, the Find File dialog appears. The following example
shows the appearance of this dialog when you try to find all
files associated with the file name VIEWMAX:

Find File |

File to find: VIEWMAX .*__

Drive to search: C:\

Files Found

:\DRDOS\VIEWMAX .EXE
*\DRDOS\VIEWHAX .OVL
:\DRDOS\VIEWMAK . RSC

:\DRDOS\VIEWMAK .ACC
:\DRDOS\UIEWMAK . INI

File to find:

Type the file name in the text field. Use DOS wildcards to
search for all files associated with a certain name or extension.
After you type the file name, select Find to start the file search.

To edit the file name, press Backspace to erase one character
at a time, or press Ctrl+Backspace to erase the whole name.

Drive to search: S

This field shows the current disk drive for the active window.
To change the drive, select the field and then type a new drive
letter.

Files Found:

This box lists the file(s) located by your file search request.
When you select a file, the Go To button is highlighted. To
display additional files, scroll the list box.

Find, Go To, or Cancel:

Select Find to start the search for the the selected file(s). The
file(s) appear in the Files Found box. Select Go To to exit the
dialog and display the selected file as a highlighted icon in the
active window. Select Cancel to exit the dialog.
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Copy command

Use this command to copy one or several folders or files to
another window. Refer to the tutorial in Chapter 2, “Getting
Acquainted,” and to the section on copying folders in Chapter 4,
“Folders,” for more details.

Delete command

This command deletes all the currently selected items. After
you have deleted them, you can retrieve them immediately by
choosing the Undelete command.

If you try to delete a file or folder that is protected by a
password, a Password Protected dialog appears. See Chapter 9,
“Passwords,” for more information on the use of passwords.

If you try to delete a file that has Read-Only status, an alert
appears. To delete the file, you must exit and then use the
Info/Rename command to change the file to Read/Write status.

Info/Rename command

When you choose this command, you see one of three dialogs,
depending on what type of item is currently selected.

The example below shows the dialog for a file.

File Information ~ Renane :

[Name:  AUTOEXEC .BAT||
Size in bytes: ________ 438
Last modified: 22-May-91 08:29 an
Attributes:
@ Read-Urite
(O Read-Only

L?2] Iga'ncelj' OK

Name:

The name of the file can be edited: press Backspace to erase
one character at a time, or press Ctrl+Backspace to erase the
whole name, and then type the new name.

Size in bytes: and Last modified:
The size in bytes and last modified date cannot be edited; they
are updated automatically when the file is altered.
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Attributes:

To change the attributes setting, use the cursor keys to move
the selection frame over the setting you want and then press
Spacebar to select it. If you are using the mouse, click on the
setting you want.

OK or Cancel
Select OK to confirm your changes. Select Cancel to abandon
any changes you have made in this dialog.

If you choose the Info/Rename command with a folder selected,
you see the Folder Information / Rename dialog:

: Folder Information ~/ Rename

Folder name: MOUSE| _.__|
Created: 27-Jul-90 06:56 an

Number of folders: 0
Number of files: 0
Bytes used: _________ 0O

(2] (Ccancel ] [ oK 1

Folder name:

The name of the selected folder. You can delete the old name
and type a new one if you want to rename the folder. Note that
this is the only data area you can modify in the dialog box.

Created:
The time, day, month and year the folder was created.

Number of folders:
The number of folders, if any, inside the selected folder.

Number of files:
The number of files inside the selected folder (a file is a
document or an application).

Bytes used:
The size in bytes of the contents of the selected folder.
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If you choose this command with a disk drive selected, the Disk
Information dialog appears, which cannot be edited:

: Disk Information

Drive identifier: C:

Disk label:
Nunber of folders: 18
Number of files: 394

Bytes used: __9,894,033
Bytes available: _22,951,936

Drive identifier:
This is the letter representing the current drive.

Disk label:
This is the name (f any) of the current disk.

Number of folders:
The total number of folders on the selected disk.

Number of files:
The total number of documents and applications on the current
disk.

Bytes used:
The total number of bytes used on the selected disk.

Bytes available:
The total number of unused bytes on the selected disk.

Password command

This command enables you to assign and remove passwords for
folders, documents, and applications. See Chapter 9,
“Passwords,” for a fuller explanation of passwords.
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Undelete command

Use this command to retrieve a file or folder that you have
deleted. When you choose this command, the DR DOS Undelete
screen appears. The Undelete screen shows a list of files and
directories you have deleted during this work session. Select
the file or directory to be restored, press Alt+F, and then press
U and O. (See the DR DOS 6.0 User Guide for more
information on the Undelete function.)

Format diskette command
To format a diskette, follow these steps:

Insert the diskette in one of your diskette drives.

@ Select the ViewMAX icon representing the drive that
contains the diskette you want to format.

Choose the Format diskette command from the File menu.

Note

ViewMAX protects your hard disk from being formatted, so
you can only format diskettes with the Format command.

Exitf fo DR DOS command
Use this command to exit ViewMAX and return to the DR DOS
operating system prompt.

Options menu commands

The Options menu contains commands that are not specific to
files and folders, but that govern the operating characteristics
of ViewMAX,

Configure application command

This command allows you to configure an application and
assign document types to it. Refer to Chapter 6, “Applications,”
to find out more about how to use this command.
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Preferences command

When you choose this command, ViewMAX displays the Set
Preferences dialog:

: Set Preferences

— Safety
Confirn deletes Confirm overurites
Confirn copies [] save configuration on exit
— Systen
Sound effects [] Click to drop down menus
Double Click Speed:
@® Slow O 2 O3 04 O Fast

(7] [Cancel] [ OK |}

Click on the preferences you want, as explained below:
Confirm deletes?

On tells ViewMAX to always display the Delete Folders / Files
dialog when you do a delete operation. Off tells ViewMAX to
bypass the dialog and begin the delete operation immediately
without waiting for your confirmation.

Confirm copies?

On tells ViewMAX to display the Copy Folders / Files dialog
whenever you do a copy operation. Off tells ViewMAX to bypass
the dialog and begin the operation immediately without waiting
for your confirmation.

Confirm overwrites?

On tells ViewMAX to display the Name Conflict During Copy
dialog whenever the copy operation you are about to perform
will cause an existing file or folder to be overwritten. This
setting warns you that the information in a previous version of
a file or folder might be lost if you continue with the copy
operation. If the check box is Off, the dialog is not displayed
and the copy operation is performed without your confirmation.
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Save configuration on exit?

On means that the current arrangement of items and windows
will be saved when you leave ViewMAX and that they will
appear the next time you start ViewMAX. Off means that the
items and windows will revert to their last saved arrangement
when you start ViewMAX.

Double-click speed:

Sets a relative speed for how quickly you must double-click the
mouse button. This does not affect the keyboard operation.

To drop down menus: (mouse only)

Switch the check box On if you want the ViewMAX menus to
drop down from the menu bar only when you place the pointer
on a menu name and click the mouse button. Switch the check
box Off if you want the menus to drop down when the pointer
touches the menu names. This is the standard or default
setting.

Sound effects:

On causes ViewMAX to sound a beep if you try to display a
menu while a dialog is on the screen. Off suppresses the beep.

OK or Cancel:

After setting the preferences the way you want, select OK to
return to ViewMAX. Your preferences take effect immediately.
If you do not make any changes or do not want to save those
you have made, select the Cancel button.

If you want to make your preferences a permanent part of
ViewMAX (that is, so they take effect every time you start
ViewMAX), use the Save preferences command.

Global password command

Use this command to specify a password for ViewMAX to use
every time it encounters an item that is password-protected.
For more details on how to use this command, see Chapter 9,
“Passwords.” The global password must be reset each time the
computer is reset.
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Color schemes command

Use this command to change the ViewMAX color scheme. When
you choose this command, the Color Schemes dialog appears:

: Color Schenes

nochrone

T s _

[7] [Cancel | [ OK |

Available Color Sets:

In this box you select color schemes that apply to the desktop
and to the scroll and title bars. When you select a name, the
Color Schemes dialog shows the color and pattern
corresponding to this name. Scroll the list to reveal more colors.

OK or Cancel:
Select OK to exit after you make your selection. Select Cancel
to exit without making changes.

Save preferences command

This command lets you set ViewMAX so that it will always
start as you currently have it configured. You can use the
command at any time and it sets the following ViewMAX
characteristics:

O The current size of the ViewMAX windows.

O The disk or folder currently opened in each ViewMAX
window. For example, if one of the windows is displaying the
contents of disk drive A: when you choose Save preferences,
ViewMAX will display the contents of that drive every time
you start, assuming there is a diskette in the drive.

O The way you currently have your applications configured
(see “Configuring Applications” in Chapter 6 for details).

O The current arrangement and display of items in ViewMAX.

O The current preference settings (see the description of the
Preferences and the TaskMAX preferences commands).
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TaskMAX preferences command

Use this command to set the way that TaskMAX operates in
ViewMAX. When you choose this command, the TaskMAX
Preferences dialog appears. (For more information about
TaskMAX, consult the TaskMAX section in Chapter 6,
“Applications,” and the DR DOS 6.0 User Guide.)

: TaskMAX Preferences:

[ VieuMAX controls TaskMAX? |

Maxinum Allouwed LIM Memory Use

0K 3072K

[Cancel | [ OK |

ViewMAX controls TaskMAX?:

If you want to use ViewMAX to access TaskMAX, select the box.
This lets you enter TaskMAX by using the TaskMAX interface
command in ViewMAX.

If you want to display the TaskMAX menu by using the
Cirl+Esc command, leave the box unselected. When this box is
not selected, the TaskMAX interface command is unavailable.

Maximum Allowed LIM Memory Use:

This slider bar lets you set the amount of memory used for
applications running under TaskMAX. You must allocate
enough memory so that each application in the task list can run
under TaskMAX. (See the DR DOS User Guide for information
On Imemory use.)

The number above the far right of the slider bar shows the
maximum memory available for your system. The black box on
the far left displays the amount of memory that TaskMAX will
allow a task to use. To change the setting, drag the slider, or
move the selection frame over the black value box and then use
any of the following keys: left arrow, right arrow, PgUp, PgDn.
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TaskMAX interface command

Use this command to display the TaskMAX Interface dialog,
which you use to access TaskMAX. This command is only
available if you have already started TaskMAX and selected the
box for the “ViewMAX controls TaskMAX?” option in the
TaskMAX Preferences dialog. (For more information about
TaskMAZX, consult the TaskMAX section in Chapter 6,
“Applications,” and the DR DOS 6.0 User Guide.)

Note

When you are in ViewMAX, you can only display the
TaskMAX menu if the box for the “ViewMAX Controls
TaskMAX?” option in the TaskMAX Preferences dialog is

not selected.

For example, if you add the DR DOS command line, the DR
DOS Editor, a word processing program, and a scanning
program to the task list, you might see the following in the
TaskMAX Interface dialog:

& : TaskMAX Interface

Suap Space fvailable
e w

Active Tasks

r'y

2 EDITOR F
3 up

4 SCANX

v

{' Run i (Delete ] [Insert |}

M e

Note

ViewMAX is not listed in the Active Tasks box because it is
the active task.
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Swap Space:

This box shows how much memory is available to start new
tasks. The percentage and the number of kilobytes shown in
this box are based on the sum of three elements that TaskMAX
uses for running tasks:

QO The memory you allotted TaskMAX.
O The space available in a swap file used by TaskMAX.
QO The amount of free hard disk space available on your system.

If the percentage shown in the box is near 0%, you must delete
an application from the task list before you try to run another
task.

Active Tasks:

This box lists the applications you have installed under
TaskMAX. To switch to another application, select the name,
and then select the Run button (or double-click on the name).
To add an application to the task list, select the Insert button.

Run, Delete, Insert, or Cancel:

Select Run to switch to the application that you selected in the
Active Tasks box. Select Delete to remove the selected
application from the list. (After you delete an application, you
can only make it active again in TaskMAX by selecting Insert
and then starting the application.) Select Insert to display the
operating system prompt so that you can start a new task. After
you start the task, press Ctrl+Esc to return to ViewMAX.
Select Cancel to exit without making any changes.

Note

When TaskMAX is active in ViewMAX, any application that
you run from the ViewMAX desktop will be started as a
new task in TaskMAX. This means that you can switch
from the application to ViewMAX by choosing the Ctrl+Esc
command. :

Enter DR DOS commands command

Use this command to go to the DR DOS command line
temporarily. You can then enter any of the DR DOS commands.
To return to ViewMAX after you finish, type the following:

EXIT.
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View menu commands

The View menu commands control how ViewMAX displays
information in the active window.

Close command

Use this command to display the contents of the folder that is
one level higher in the directory structure. (To do this, you can
also press Alt+F4, or click on the close box.) For example, if the
active window contains the icons from a folder called
EXPENSES that is one level below a folder called FINANCE,
when you choose the Close command an icon representing the
FINANCE folder appears. If you were to choose the command
again, you would see an icon representing your FINANCE
folder.

Resize command

This command switches between a display of the currently
active window at normal and at full-screen size. You might find
it helpful to use the larger display if you have a full window of
icons and you want to see as many icons as possible without
scrolling. The alternatives to using this command are to click
on the resizing box or to press Alt+F5.

Refresh command

This command refreshes the active window to give you the
latest display of its contents. If one of your windows is
displaying the contents of a diskette, and you then remove that
diskette and replace it with another, you can update the display
by using the Refresh command or by pressing F5.

Show/Hide free command

Use the Show tree command to display the contents of an active
window in two side-by-side windows (split-window mode). The
left window displays folders in a tree structure; the right
window displays the contents of any selected folder or root
directory of a drive. If more than one item is selected in an
active window, this command is inactive.

After you choose the Show tree command, the Hide tree
command appears in the View menu. Choose this command to
return to the normal, full window display.
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To display the contents of a folder in the right window, place the
selection frame on a folder in the left window and then press
Enter (or double-click on the folder).

For example, if C: is the current drive when you select the
\DRDOS directory and then press Enter, you will see
something similar to the following:

THMP
[-1—YENTURA |__',
| L pIcT D D
[—]_TVPESET VENTURA RUTOEXEC.BAK RUTOEXEC.BAT AUTOEXEC.OLD
(-1—LEVELZ 1 O 0O 0O
[-1—LEVEL3 COMMAND.COM  CONFIG.BAK  CONFIG.OLD  CONFIG.SYS
[-1—LE&
L (1 01 [
4' DDIR.COM DPOUT.BAT DPSETUP.BRAT DRAW.BAT
| s [r—

Any directory in a tree that contains subdirectories has either a
plus [+] or a minus [-] beside it. The [+] indicates that the
subdirectories are not shown; the [-] indicates that the
subdirectories are displayed. Thus, in the example shown
above, all the subdirectories are displayed.

To hide the subdirectories of the \TYPESET directory in the
example shown above, you would move the selection frame over
the directory name and then press Alt+[-](the minus key on
your keyboard), or double-click on the [-] that is to the left of
the directory name. You would see the following:

16 folder(s). 4 folder(s). 297,595 bytes in 49 file(s).

a —
[-1—DRDOS 7 &
I I THP New Folder DRDOS MOUSE TVYPESET
[-1—UENTURA D D
TR [
E +]—T$FE§E'A‘[~ ; VENTURA RUTOEXEC.BAK AUTOEXEC.BAT AUTOEXEL.OLD
2= mEREE
COMMAND.COM CONFIG.BAK CONFIG.OLD CONFIG.SYS
< 1 1 1 [
4' ‘ * DDIR.COM DPOUT.BAT DPSETUP.BAT DRAW.BAT
—n o prm— [—

To display the subdirectories below the \TYPESET directory,
you would press Alt+[+] (the plus sign on your keyboard), or
double-click on the [+].
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To display or hide subdirectories in the tree structure, use the
following keys on your keyboard, or click on the screen with
your mouse:

3 To display the subdirectories that are one level below the
selected directory, press [+] or click on the [+].

a To display all subdirectories below the selected directory,
press Alt+[+] or double-click on the [+].

QO To hide the subdirectories that are one level below the
selected directory, press [-] or click on the [-].

@ To hide all subdirectories below the selected directory, press
Alt+[-] or double-click on the [-].

For directories that contain many subdirectories, you might
have to use the horizontal scroll bar to display all the
subdirectories. Press Ctrl+Pg Up to move the horizontal scroll
bar to the right; press Ctrl+Pg Dn to move the horizontal
scroll bar to the left. You can also use the left and right arrow
keys to move the scroll bar.

Press the Tab key (or Shift+Tab) to switch between the
windows. Use the up and down cursor keys to move the
selection frame and the Spacebar to select folders. Press
Enter to open a selected folder and display its contents in the
right window. Use the normal keyboard techniques to
manipulate the folders. If you open a folder, you will see a
display of icons or text, depending on what you had previously
selected.

Use Pg Up and Pg Dn to scroll up and down the display, or
click on the scroll arrows and drag the slider if you are using a
mouse. Press Home to go to the beginning of the display; press
End to go to the end of the display.
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Show as text command

To display the contents of a window as text, select the Show as
text command. This display gives you additional information
about each file, as shown in the following full window display
for drive C:

297,595 bytes in 49 file(s)

4 folder(s).
H Neu Folder

sorted by name.

DRDOS

MOUSE
TYPESET
UVENTURA
AUTOEXEC BAK
AUTOEXEC BAT
AUTOEXEC OLD
COMMAND COM
CONFIG BAK
CONFIG  OLD

193
193
425
50,118
704
J04

21-Jun-90
86-Apr-91
26-Sep-90
26-Sep-90
06-Apr-91
06-fipr-91
05-Apr-91
20-May-91
06-Apr-91
05-Apr-91

45 pn --d-

26 am ~--d-
18 pm = --d-
18 pn --d-
33 am  -a—-
34 am  -a--
33 pn -a--
00 am  -a—-
21 am  ra--
08 pn -a-p

Folders appear first, but the file sizes in bytes are shown in a
column to the right of their name. The next column shows the
date and time that each of the files was last modified. The final
column uses several abbreviations to describe the files; these
are known as file attributes:

a stands for archive and means that the file has been altered
since it was last saved; therefore, you might want to make
a backup copy of it.

d signifies a directory.

p means that a file is password-protected.

r means that a file is read-only; you cannot change or delete it.

Refer to the DR DOS 6.0 User Guide for a complete description
of file attributes.

Note

In split-window mode, the right window does not display
file attributes.

Show as icons command

This command displays the contents of a window as icons with
the names listed beneath them. For details of what the
different icons mean, see Chapter 5, “Icons.”
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Name order command

This command arranges the icons alphabetically. Folders are
kept together and appear first, and New Folder will always
appear as the first icon.

Type order command

This command arranges the icons in the right window
alphabetically by types, so that, for example, all .APP files
appear first, followed by all .BAK files.

Size order command

This command arranges the files by their size in bytes. The
largest files are listed first. Folders are grouped together and
appear first but are not arranged by size.

Date order command

This command arranges the files according to the date they
were created or last modified. Files with the most recent dates
appear at the beginning of the list. Folders appear first but are
not arranged by date.

Wildcards command

This command enables you to display a subset of the files
available by using the wildcards ? and *. When you choose this
command, the Display by Wildcard dialog appears:

Wildcards:
li* .*I

[?] [Cancel] | Ok |

The question mark wildcard (?) stands for any character in the
exact position it occupies in a file name.
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The asterisk wildcard (*) stands for a variable number of
characters: between none and eight characters for the file
name, and between none and three characters for the file type.

If you want to display only files with the extension BAT in your
active window, tell ViewMAX to show you files matching *.BAT.

If you want to see the set of files beginning with CHAP, ask for
files matching CHAP*.*,

If you want to see the set of files with a three-character name,
ask for files matching ???.* and so on.

Use the Backspace key to delete the existing text in the
wildcards dialog, then type in your choice and select OK.

Refer to the DR DOS 6.0 User Guide for a fuller explanation of
how to use wildcards.
Help menu commands

Menus

This dialog provides information about manipulating the
ViewMAX menus.

Help on Menus G

The following keys let you perform actions with menus:

Alt+letter> pull a menu doun

(letter underlined in menu name)
Alt+{letter>+<{letter> choose a command from a menu

(letter underlined in menu command)

torl highlight a menu command

€ or * suitch to an adjacent menu

Enter choose a highlighted menu comnand
Esc remove a menu from the screen

F1 display the Help menu

Fi0 display the ViewMAX menu
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Dialogs

This dialog provides information about how to utilize the
features of dialogs.

Help on Dialogs
The following keys let you perform actions in dialogs:
Enter accept the current settings and exit

the dialog
Esc exit the dialog without making changes
1 or Shift+Tab move to the previous iten
i move to the next iten
€« or » move to the previous or the next item
Backspace delete previous character in a text field
Ctrl+Backspace clear a text field
D ]
Windows

This dialog provides information about manipulating the
ViewMAX windows.

Help on Windows

The follouing keys let you perforn actions in a window:
Space Bar Select a folder or file

Esc de-select a folder or file

Enter open a folder or file

ti+0p¢ nove the selection frame

PgUp or PgDn scroll up or doun

Tab switch to another window

F5 refresh the contents of a windouw
Alt+F4 display the previous open folder
Alt+FS nininize or maxinize the window

DL




80 ViewMAX User Guide

Trees

This dialog provides information about how to manipulate the
directory tree structure displayed in the left window in
split-window mode.

3 Help on Trees i

The follouwing keys let you perform actions on trees:

+ shouw all subdirectories one level
below the main directory
Alt+<+> show all subdirectories below the

main directory
- hide all subdirectories one level
below the main directory

Alt+<—> hide all subdirectories below the
main directory

PgUp or PgDn scroll up or doun

Ctrl+PgUp or Ctrl+PgDn scroll left or right

Home or End scroll to the beginning or end

ViewMAX menu commands

Information command

This command displays the date and the release of the
ViewMAX software.

Cdlculator

This command displays the ViewMAX calculator. Press Alt+F4,
or click on its close box to close it.

Clock

This command displays the ViewMAX clock. Press Alt+F4, or
click on its close box, to close it.




Passwords

password is equivalent to having a lock on a door: it is a way of

ontrolling who can enter. In ViewMAX terms, a password can stop
other people from looking at your folders and files, and stop them from
copying or deleting your data.

ViewMAX lets you create your own passwords and assign them
to different files or folders, and you can remove or change them
as you want.

This chapter describes how to set, change, and remove
passwords, and it explains the different levels of password
protection. It also shows how to set up a global password.

Setting passwords

Assume that you want to set a password for a document on
drive A:. Select the file to which you want to assign a password,
and then display the File menu. After you choose the Password
command from the menu, you will see the Assign / Remove File
Password dialog, as shown in the following example:

Assign ~ Remove File Passuword

Nane.; T

A BA
i Password: !__ f
Protection:
@ Delete
O DeleteUrite
(O DeleteUritesRead

(7] (CBemove ] [ cCancel | [Cassign |

The name of the file you chose appears at the top of the dialog.
At the text cursor (the vertical bar by the word “password”),
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type in the password you want. The characters you type can be
in upper or lower case: ViewMAX will understand the password
Fred entered as FRED, fred, FrEd, and so on.

Next, select the level of protection you want. There are three
levels of password protection:

O Delete is the lowest level: no one can delete the item you
have protected, unless the correct password is given.

O Delete/Write is the intermediate level of protection: unless
the password is given, the protected item cannot be deleted
or edited in any way.

@ Delete/Write/Read is the highest level of protection: no one
can even look at the item unless the correct password is
given. This means that no one can edit, copy, or delete the
item either.

Next, click on the Assign button (or press Alt+A). If you change
your mind about setting the password at this point, or mistype
it, choose Cancel instead and start again.

When you choose the Password command for a folder, the
Assign / Remove Folder Password dialog appears, as shown in
the following example:

i Assign » Remove Folder Password

Folder: UTIL .

|Passuord: | !
(TBemove ] [ Cancel J [_@ssign |

If you are protecting a folder with a password, ViewMAX sets
the protection level to delete/write/read.

When you try to perform an operation on a file that is protected
by a password, the Password Protected File dialog appears, as
shown in the following example:

: Password Protected File
NOMOUSE .BAT |

{Passuord: ! l

7] [Cancel ] | OK 1
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To complete the operation on the file, you must type the
password and then select OK.

When you try to perform an operation on a folder that is
protected by a password, the Password Protected Folder dialog
appears, as shown in the following example:

Passuord Protected Folder 7
CMG

iPassuord : ! !

(7] [camcel] [_OK ]

To complete the operation on the folder, you must type the
password and then select OK.

Removing a password

You might decide that you want to remove the password
protection that you have given your files. To do this, follow
these steps:

Select the item you want to remove the password from and
then choose the Password command.

Type the current password at the text cursor and then
click on the Remove button. You will no longer need to
enter the password when you select that item.

Changing a password

If you have set a password for an item and then find that you
want to change it, follow these steps:

Select the item you want to change and then choose the
Password command.

Type the new password at the text cursor and then choose
the Assign button.

When the Password Protected dialog appears, type in the
old password and select the OK button—the new password
is now valid.
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Setting a global password

Because it is easier to remember just one password, you might
want to use the same password for various folders and
documents. To save you from having to type the same thing
every time, you can use the Set Global password command from
the Options menu. After you choose this command, the
following dialog appears:

4

[ Assign # Remove Global Passuord &

lPassuord: ! i
(Remove | [Cancel ] [ Assign ]

This command will automatically supply the password you give
it every time ViewMAX requires a password. (If you assign a
different password to a few of your files, you will still need to
type it for them, but the majority will be handled automatically.)

To set a global password, follow these steps:

Select the Global password command from the Options
menu.

@ When the Assign/Remove Global Password dialog appears,
type the password at the text cursor and select the Assign
button. The global password is now set.

Removing a global password

When you leave ViewMAX, the global password that you set
remains active. To remove this password, choose the Global
password command again and then select the Remove button.

Changing a global password

To change the global password, choose the Global password
command, type the new password, and then select Assign—it is
changed automatically.

Note

You need to reset the global password every time your
computer is reset.




Glossary

active window

This is the window in which you can perform operations. Only
one window can be active at a time. You can tell which window
is currently active because there is a selection frame around the
first item in the window. You make a window active either by
clicking in it with the mouse, or by pressing the Tab key.

application

An application is a program, such as a word processor, that you
use on your computer. You can use applications from within
ViewMAX by opening the icon that represents the application.

button

A button is a graphical representation of an option on the
screen. Typically it is a word or a few words surrounded by a
rectangle. You can select a button in several ways:

QO by clicking on it with the mouse

O by moving the selection frame over it with the cursor keys
and then pressing Spacebar

[ by pressing Alt+underlined letter
The buttons you will see most often are the QK and Cancel

buttons.
click

A mouse technique: to click is to press and then immediately
release the mouse button.
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default button

The button with a thicker black rectangle around it in a dialog.
It is the one you can select by pressing Enter. In ViewMAX,
the OK button is most often the default button.

dialog box

A small screen that appears over the ViewMAX windows. It
provides or requests information.

document

A term that describes various kinds of data files.

double-click

To press and release the mouse button twice, quickly. Its
keyboard equivalent is pressing the Enter key.

dragging

The action of clicking and then holding down the mouse button
while moving the mouse pointer across the screen.

folder

This is the equivalent of a DR DOS directory or subdirectory. A
folder can contain documents and other folders.

icon

An icon is a small symbolic picture. ViewMAX icons represent
disk drives, folders, and files. Refer to Chapter 5, “Icons,” for
more information.

list box

Abox in a dialog that shows you a list of choices. You can scroll
through the choices in the box. To select an item from the list,
double-click on it, or place the selection frame on it and then
press Enter.

menu

The display of choices from which you select your commands. In
ViewMAX, you display the menus from the menu bar (see
menu bar).
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menu bar

Alist of menu titles along the top of the screen. The menu bar
contains the titles File, Options, View, Help, and ViewMAX.

radio button

A radio button is different from a normal button in that when it
is selected, it causes an adjacent button to become deselected.
Its name comes from the sort of push-button controls that are
found on radios.

root directory

The root directory is the main directory on any disk. All
first-level subdirectories are part of the root directory. Both
subdirectories and files can be kept in the root directory.

rubber rectangle

When you drag the mouse pointer around several items, the
rectangle that appears is called the rubber rectangle. You start
dragging from the top left corner of the first item you want to
include, and then continue to the bottom right corner of the last
item. Once you have drawn a rubber rectangle around several
items, you can perform the same commands on all of them at
once. This is useful if you have several items that you want to
copy or delete. '

scroll bar

The scroll bar appears at the right edge of a window in normal
window display; in split-window mode, scroll bars appear along
the bottom edge and the right edge. The scroll bar contains
scroll arrows and a slider, and the slider indicates what
proportion of the window is currently visible. Use the scroll
arrows to move the slider up and down, or to move left and
right, to reveal a different portion of the window.

scrolling

This describes moving up and down, or left and right, through a
list of options by using the scroll bar. You scroll through the
contents of a window when there are too many items to see. For
vertical scrolling, the keyboard equivalents to use are the
PgUp and PgDn keys; for horizontal scrolling, use Ctrl+PgUp
and Ctrl+PgDn.
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shiff-clicking

You shift-click when you press the Shift key and click with the
mouse at the same time. You use this technique to select
several items at once when they are not all grouped.

split-window mode

The mode that results when you choose the Show tree
command: the left window displays a tree structure for the
current drive, while the right window displays the contents of
any selected directory.

window

Your ViewMAX screen is divided into windows: when you start
ViewMAX, the top part of the screen is split into two windows,
and the bottom part contains one window. Each window shows
you the contents of a disk or a folder. The windows are
independent of one another, and you can switch between them
by using the Tab key, or by clicking in the window you want to
use.




Index

A

active window, 4, 18, 87
APP application type, 37
applications

configuring, 40

definition of, 87

icon, 34

removing configuration of, 42

saving configuration of, 41

starting, 38

types of, 37

using TaskMAX with, 44, 71
Assign / Remove File Password dialog, 81
Assign / Remove Folder Password dialog, 82
Assign / Remove Global Password dialog, 85

BAT application type, 37
button, 87

C

calculator, 45, 60, 80
EC and C keys, 46
memory keys, 45
cancel button, 50, 87
changing a global password, 85
changing passwords, 84
clicking, 87
clock, 46, 60, 80
check boxes, 15

close box, 19

Close command, 58, 73

Color schemes command, 57, 69
Color Schemes dialog, 69

COM application type, 37

Configure application command, 35, 40, 57, 66

removing an application, 42
saving an application, 41
Configure Application dialog, 39 - 41
Confirm copies, 67
Confirm deletes, 67
Confirm overwrites, 67
Copy command, 8, 56, 63
Copy Folders / Files dialog, 67
copying folders, 29
creating a new folder, 27

D

data entry dialogs, 49, 51 - 52

data entry fields, 51

Date order command, 58, 77

default button, 50, 88

Delete command, 56, 63

Delete Folders / Files dialog, 67

deleting folders, 30

deleting icons, 30

deselecting
boxes, 44
items, 5

dialogs
Assign / Remove File Password, 81
Assign / Remove Folder Password, 82
Assign / Remove Global Password, 85
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Color Schemes, 69

Configure Application, 39 - 41
Copy Folders / Files, 67

data entry type, 49, 51 - 52
definition of, vii, 88

Delete Folders / Files, 67
Disk Information, 65

File Information / Rename, 51
Find File, 62

Folder Information / Rename, 63

Help for, 49
Help on Dialogs, 79
Help on Menus, 78
Help on Trees, 80
Help on Windows, 79
icons, 51
information type, 49 - 50
Name Conflict During Copy, 67
New Folder, 28
Open a File, 39
Open Application, 38 - 39, 41
Password Protected File, 83
Password Protected Folder, 83
TaskMAX Interface, 43, 71
TaskMAX Preferences, 43, 70
Dialogs command, 59, 79
disk drive, vii
icon, 33
identifier, 33
label, 33
Disk Information dialog, 65
disk size, 22
displaying menus, 6
documents
definition of, 88
icons, 34
types of, 37, 40
double-click, 88
double-click speed, 68
dragging, 5, 88
Drop-down menu control, 68

EC and C keys, 46

EXE application type, 37

exit buttons, 49

Exit to DR DOS command, 66

F

file attributes, 76

File Information / Rename dialog, 51

File menu, 6, 56

File menu commands, 56, 61
Copy, 56, 63
Delete, 56, 63
Exit to DR DOS, 56, 66
Find, 56, 62
Format disk, 56, 66
Info/Rename, 56, 63
Open/Run, 56, 61
Password, 56, 65
Show contents, 56, 61
Undelete, 56, 66

Find command, 56, 62

Find File dialog, 62

Folder Information / Rename dialog, 64

folders, 27, 29, 31
copying, 29
creating new, 27
definition of, vii, 88
deleting, 30
deleting files from, 30
icon, 33
inside other folders, 28
order of icons, 33
placing icons inside, 29
renaming, 31
size of, 22

Format disk command, 56, 66

G

Global password command, 57, 68
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H

Help menu, 6, 59

Help menu commands, 59, 78
Dialogs, 59, 78 - 79
Menus, 59, 78
Trees, 59, 80
Windows, 59, 79

icons, 33, 35
application, 33 - 34
definition of, 88
disk drive, 33
document, 33 - 34
folder, 33
generic, 35
placing inside folders, 29
types, 34
Info/Rename command, 56, 63
Information command, 60, 80
information dialogs, 50
information line, 4, 19
installation, 1

K

keyboard
alternatives, 6, 55
shortcuts, 14
techniques, 5
tutorial, 8

L

list box
definition of, 88

M

memory keys, 45
menu bar, 89
menus
definition of, 88 -
displaying, 6
drop down, 68
File, 6, 56, 61
Help, 6, 59, 78
Options, 6, 57, 66
View, 6, 58, 72
ViewMAX, 6, 60, 80
Menus command, 59, 78
mouse, vii
mouse buttons, 5
mouse techniques, 5
mouse tutorial, 11

N

Name Conflict During Copy dialog, 67
Name order command, 58, 77

New Folder, 27

New Folder dialog, 28

o

Open a File dialog, 39

Open Application dialog, 38 - 39, 41

Open/Run command, 38, 56, 61

Options menu, 6, 57

Options menu commands, 57, 66
Color schemes, 57, 69
Configure application, 57, 66
Enter DR DOS commands, 57, 72
Global password, 57, 68
Preferences, 57, 66
Save preferences, 57, 69
TaskMAX interface, 43, 57, 71
TaskMAX preferences, 43, 57, 70
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P

Password command, 56, 65
Password Protected File dialog, 83
Password Protected Folder dialog, 83
passwords, 81, 83, 85

changing , 84

changing global, 85

global, 84

removing, 83

removing global, 85

setting, 81

setting global, 84
pointer, moving the, 5
Preferences command, 6, 57

R

radio buttons, 52, 89

Refresh command, 58, 73

removing a global password, 85

removing an application’s configuration, 42
removing passwords, 84

renaming folders, 31

Resize command, 58, 73

resizing box, 19

root directory, 42, 89

rubber rectangle, 5, 89

S

Save configuration on exit, 68
Save preferences command, 57, 69
saving an application’s configuration, 41

“scroll arrows, 22 - 23,75

scroll bar, 22, 89
scroll techniques, 24

" scrolling techniques, 22, 24, 75, 89

search path, 39, 42

selection bar, 5, 20

selection frame, 5, 18

Set preferences command, 67
Set Preferences dialog, 67

setting a global password, 84
setting passwords, 81
Shift-clicking, 5, 90
shortcuts, 55
Show as icons command, 58, 76
Show as text command, 58, 76
Show contents command, 56, 61
Show/Hide tree command, 58, 73
Size order command, 58, 77
slider, 22
Sound effects, 68
split-window mode, 4, 17, 23 - 25, 73, 90
keyboard shortcuts for, 15
starting applications, 38
starting ViewMAX
automatic startup, 2
from a diskette, 2

T

TaskMAX
using TaskMAX menu in ViewMAX, 44
using ViewMAX to enter, 43
TaskMAX interface command, 43, 57, 71
TaskMAX Interface dialog, 43, 71
TaskMAX preferences command, 43, 57, 70
TaskMAX Preferences dialog, 43, 70
title bar, 4, 18
To drop down menus, 68
Trees command, 59, 80
tutorial, 3-4,7- 13
Type order command, 58, 77

U

Undelete command, 56, 66

\'

View menu, 6, 58

View menu commands, 58, 73
Close, 58, 73
Date order, 58, 77
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Name order, 58, 77
Refresh, 58, 73
Resize, 58, 73
Show as icons, 58, 76
Show as text, 58, 76
Show/Hide tree, 11, 58, 73 - 74
Size order, 58, 77
Type order, 58, 77
Wildcards, 58, 77
ViewMAX accessories, 44
calculator, 45
clock, 46
VIEWMAX diskette, 2
ViewMAX menu, 6, 44
ViewMAX menu commands, 60, 80
Calculator, 60, 80
Clock, 60
Information, 60, 80
ViewMAX startup
automatic startup, 2
diskette startup, 2

w

Wildcards command, 58, 77
windows
active, 4,7, 18
close box, 19
definition of, 90
displaying contents in, 25
information line, 19
resizing box, 19
saving, 25
scroll arrows, 23
scroll bar, 22
slider, 22
split-window mode, 4, 17, 23 - 25, 73
title bar, 18
Windows command, 59, 79
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